A Reference guide to Using the Collaborate tool in your LMS (Windows Users)
Your LMS includes a synchronous (real-time) tool for online communication within your subject
or community. The Collaborate tool in your LMS enables you to participate in webinars, realtime discussions, workshops, test review sessions etc. You can also access this tool to view
recorded sessions and use them for later reference.

This guide includes instructions on how to join a collaborate session or access a recorded
session. For instructions on specific tasks as outlined below, click the links corresponding to
each task.
Download and install the Blackboard Collaborate Launcher
Join a collaborate session
Set up your audio and microphone
Use the Blackboard Collaborate window tools
Use the whiteboard and the associated tools palette
Access a recorded collaborate session
View a recorded collaborate session

Download and install the Blackboard Collaborate Launcher
To use the collaborate feature in your LMS, Java must be enabled in your browser. If you do not
have Java on your computer, you can download the Blackboard Collaborate Launcher. The
launcher is a utility for Windows and Mac that helps you easily launch a collaborate session.
Installing the launcher triggers the automatic download of the .collab file. When you open the
.collab file, the launcher unpacks this file to launch the session using a known and stable version
of Java. The launcher includes the required Java and therefore, your do not need to maintain a
system version of Java.

Before you start, please ensure that pop-ups are enabled for your browser and browser toolbars
such as Yahoo or Google toolbars.
To download and install the Blackboard Collaborate Launcher, perform the following steps:

1. On your subject’s navigation menu, click the link with the word Collaborate in it
2. On the corresponding Collaborate page, click the link for the scheduled session. For
example, to access the collaborate room for the subject ‘Current Evaluation and
Research Topics’, on the Collaborate room and session recordings page, click the link
Press here to enter the CERT Collaborate room.
3. On the Room Details page, click the link download the Blackboard Collaborate
Launcher. Please note that, first time users attempting to join a collaborate room or
access a recorded session will be prompted to download the Blackboard Collaborate
Launcher. Also, if you use a different browser to log onto your LMS and try joining a
collaborate session, you will be prompted to download the launcher. For example, you
normally use the Chrome browser. However, due to some reason, you are using Firefox.
In this case, when you try to join a collaborate session, you will be prompted to
download the launcher.
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Internet Explorer users
In the First time using the Blackboard Collaborate? dialog box, under Get the
Launcher, click the Download Launcher button.
In the notification bar at the bottom of your Internet Explorer window, click the Save
arrow, and then on the menu, click Save and run. Please be patient when the zip file for
the launcher is downloading. You can view the progress of your download in the
notification bar at the bottom of your IE window.
After the download is complete, the Blackboard Collaborate Launcher Setup wizard is
displayed.
a. On the Welcome to the Blackboard Collaborate Launcher Setup Wizard
page, click Next.
b. On the Ready to Install page, click Install.
c. On the Completing the Blackboard Collaborate Launcher Setup Wizard
page, click Finish.
Next, on your LMS, in the First Time Using Blackboard Collaborate? dialog box, under
Install the Launcher, click OK.
In the notification bar at the bottom of your IE window, click Open. If you access a
collaborate session on campus through the proxy server, you will notice a series of 16
Java Error pop-up boxes. You need to click OK in each pop-up box. Please be patient as
you do this. There is a time lapse between the Error pop-up boxes that appear. After the
first eight Error pop-up boxes, the Security Warning dialog box is displayed.
In the Security Warning dialog box, under Do you want to run this application?, click
Run. You will need to click OK for eight more Error pop-up boxes before your session
opens in a new window.

Firefox users
4. In the First time using the Blackboard Collaborate? dialog box, under Get the
Launcher, click the Download Launcher button.
5. In the Opening BlackboardCollaborateLauncher dialog box, click Save File. Please be
patient when the zip file for the launcher is downloading. This may take a while. You can
view the progress of your download on the Firefox icon on your task bar.
6. After the download is complete, navigate to the location of the zip file in your
Downloads folder, and then double-click the BlackboardCollaborateLauncher zip file.
7. In the Open File – Security Warning dialog box, under Do you want to run this file?,
click Run. This displays the Blackboard Collaborate Launcher Setup wizard.
a. On the Welcome to the Blackboard Collaborate Launcher Setup Wizard
page, click Next.
b. On the Ready to Install page, click Install.
c. On the Completing the Blackboard Collaborate Launcher Setup Wizard
page, click Finish.
8. Next, on your LMS, in the First time using the Blackboard Collaborate? dialog box,
under Install the Launcher, click OK.
9. In the Opening meeting,collab dialog box, click the Open with radio button, and then
click Browse.
9. In the Choose Helper Application dialog box, under Send this item to:, double-click
Blackboard Collaborate Launcher, and then in the Opening meeting,collab dialog
box, click OK. If you access a collaborate session on campus through the proxy server,
you will notice a series of 16 Java Error pop-up boxes. You need to click OK in each popup box. Please be patient as you do this. There is a time lapse between the Error pop-up
boxes that appear. After the first eight Error pop-up boxes, the Security Warning dialog
box is displayed.

10. In the Security Warning dialog box, under Do you want to run this application?, click
Run. After you click OK for five more Error pop-up boxes the Blackboard Collaborate
dialog box is displayed.
11. In the Blackboard Collaborate dialog box, click the Select connection speed arrow,
from the list, select your connection type, and then click OK. After three more Error popup boxes, your session opens in a new window.
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Chrome Users
In the First time using Blackboard Collaborate? dialog box, under Get the Launcher,
click the Download Launcher button. Please be patient when the zip file for the
launcher is downloading. You can view the progress of your download on the circular
progress indicator in the downloads bar at the bottom of your Chrome screen.
After the download is complete, in the downloads bar at the bottom of your screen, click
the BlackboardCollaborateLauncher zip file.
In the Open File – Security Warning dialog box, under Do you want to run this file?,
click Run. This displays the Blackboard Collaborate Launcher Setup wizard.
a. On the Welcome to the Blackboard Collaborate Launcher Setup Wizard
page, click Next.
b. On the Ready to Install page, click Install.
c. On the Completing the Blackboard Collaborate Launcher Setup Wizard
page, click Finish.
Next, on your LMS, in the First time using the Blackboard Collaborate? dialog box,
under Install the Launcher, click OK.
In the downloads bar at the bottom of your Chrome screen, click the meeting.collab file.
If you access a collaborate session on campus through the proxy server, you will notice a
series of 16 Java Error pop-up boxes. You need to click OK in each pop-up box. Please be
patient as you do this. There is a time lapse between the Error pop-up boxes that appear.
After the first eight Error pop-up boxes, the Security Warning dialog box is displayed.
In the Security Warning dialog box, under Do you want to run this application?, click
Run. You will need to click OK for eight more Error pop-up boxes before your session
opens in a new window.

Join a collaborate session
Before you launch a collaborate session, ensure that pop-ups are enabled for your browser and
browser toolbars such as Yahoo or Google toolbars. It would be advisable to join 15 to 20
minutes before your session starts so that, you have sufficient time to open the .collab file and
set up for the session.
Please note that, first time users attempting to join a collaborate room or access a recorded
session will be prompted to download the Blackboard Collaborate Launcher. Also, if you use a
different browser to log onto your LMS and try joining a collaborate session, you will be
prompted to download the launcher. For example, you normally use the Chrome browser.
However, due to some reason, you decide to use Firefox. In this case, when you try to join a
collaborate session, you will be prompted to download the launcher. However, if you already
downloaded the launcher, in the First time using Blackboard Collaborate? dialog box, click
the link Launch Blackboard Collaborate now.

To join a collaborate session, perform the following steps:

1. On your subject’s navigation menu, click the link with the word Collaborate in it.
2. On the corresponding Collaborate page, click the link for the session you want to join.
3. On the Room Details page, click Join Room.
Internet Explorer users
4. In the notification bar at the bottom of your IE window, click Open. If you access a
collaborate session on campus through the proxy server, you will notice a series of 16
Java Error pop-up boxes. You need to click OK in each pop-up box. Please be patient as
you do this. There is a time lapse between the Error pop-up boxes that appear. After the
first eight Error pop-up boxes, the Security Warning dialog box is displayed.
5. In the Security Warning dialog box, under Do you want to run this application?, click
Run. Click OK for eight more Error pop-up boxes, and then your session opens in a new
window.

Firefox users
4. In the Opening meeting.collab dialog box, click OK. If you access a collaborate session
on campus through the proxy server, you will notice a series of 16 Java Error pop-up
boxes. You need to click OK in each pop-up box. Please be patient as you do this. There is
a time lapse between the Error pop-up boxes that appear. After the first eight Error popup boxes, the Security Warning dialog box is displayed.
5. In the Security Warning dialog box, under Do you want to run this application?, click
Run. Click OK for eight more Error pop-up boxes, and then your session opens in a new
window.
Chrome users
4. In the downloads bar at the bottom of your Chrome screen, click the meeting.collab file.
If you access a collaborate session on campus through the proxy server, you will notice a
series of 16 Java Error pop-up boxes. You need to click OK in each Error pop-up box.
Please be patient as you do this. There is a time lapse between the Error pop-up boxes
that appear. After the first eight Error pop-up boxes, the Security Warning dialog box is
displayed.
5. In the Security Warning dialog box, under Do you want to run this application?, click
Run. You will need to click OK for eight more Error pop-up boxes before your session
opens in a new window.
Set up your audio and microphone
The Audio Setup Wizard allows you to configure your speaker/headphones and microphone
settings. You can the access the Audio Setup Wizard by using the options in the Audio & Video
panel to the left of the Blackboard Collaborate window or from the Tools menu on the action
bar.

Let us now consider how to use the options on the Audio Setup Wizard:

1. To launch the Audio Setup Wizard, in the Blackboard Collaborate window, in the
Audio & Video panel, in the top-right corner, click the Options menu
then on the menu, select Audio Setup Wizard. Or

icon, and
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In the Audio & Video panel, click the Audio Setup Wizard
icon to the left of the
options menu icon. Or
On the menu bar, click Tools, on the drop-down menu, point to Audio, and then on the
submenu, click Audio Setup Wizard.
To setup your audio device, in the Audio Setup Wizard, on the Select Audio Output
Device page, select either the Headphone or the Speakers/Headphones option, and
then click OK.
To adjust the speaker volume, on the Speaker Setup page, click Play, listen to the
instructions and accordingly move the slider to increase or decrease the volume for the
audio.
To confirm the setting, on the Speaker Setup Confirmation page, click Yes.
To configure the microphone settings, on the Select Audio Input Device page, click OK.
To test your microphone and adjust the microphone volume, on the Microphone Setup
page, click Record. Move the slider to set your microphone volume.
To listen to the recorded audio and confirm your microphone settings, on the
Microphone Playback page, click Play, and then on the Microphone Setup
Confirmation page, click Yes. If you are unable to hear the recorded message with the
same intensity and clarity when recording it, on the Microphone Setup Conformation
page, click No. Next, on Microphone Problem Resolution page, read the
troubleshooting tips, click Try Again, and then follow the instructions on the
corresponding pages to reset your microphone.
To finish your audio device and microphone setup, on the Setup Complete page, click
OK.

Use the Blackboard Collaborate window tools
The Blackboard Collaborate window is the interface that includes tools which allow you to
participate in real-time sessions, send text messages and use the whiteboard page. The Side Bar
to the left of the window includes the Audio & Video, Participants and the Chat panels.

Instructors who organize collaborate sessions define permissions for its participants.
Depending on the permissions assigned to you by your instructor, you can use tools such as
chat, whiteboard, application sharing, and web tour. In addition, you can talk in a session and
transmit your video if you are allowed to do so. If you have active permissions, you are
represented with a full color icon. If you are not allowed access to certain tools on your
interface, you are represented with a gray-toned icon. Icons for tools that you have permissions
to use are displayed to the right of your name in the Participants panel. Point your cursor to an
icon to view the description for that icon.

Let us now look at how you can use the tools in your Blackboard Collaborate window:

1. To send a text message to all participants, in the Blackboard Collaborate window, in
the Chat panel, in the text box, type your message, and then press Enter.
2. To send a private message to a specific participant, in the Participants panel, right-click
the name of that participant, and then on the menu, select Send a Private Chat. In the
corresponding text box, type your message, and then press Enter. You will notice that a
new tab with the name of that participant appears in the Chat panel. Please note that,
private messages are not recorded. Private messages that you receive appear in the Chat
panel as a new tab with the name of the sender and a callout symbol.
3. To view a private message that you received, in the Chat panel, click the tab that
displays the sender’s name with a callout symbol.
4. To close the tab for a private chat, in the Chat panel, on the private chat tab, point to the
user icon to the left of the sender’s name, and then click the close icon that appears.
5. To raise hand and request permission or register your presence, in the Participants

panel, under your name, click the Raise Hand
icon.
6. To participate in a poll, in the Participants panel, under your name, point to the Poll

icon, and then from the list, select Yes, No, or None.
7. To step away from a session for a brief period of time, in the Participants panel, under
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your name, click the Status
icon. When you use this option, you will notice that
your status is displayed as Away. Click the same icon to return to and continue the
session.
To use the microphone and talk during a session if required, in the Audio & Video
panel, click Talk. You will notice that a microphone icon appears on the Talk option and
to the right of your name on the Participants panel.
To adjust your microphone volume when talking, in the Audio & Video panel, move the
slider above the Talk option. To stop using the microphone, click the Talk option.
To turn on the camera of your device and preview your video, in the Audio & Video
panel, click the user icon to the right of the Video option. You will be able to view
yourself in the preview section of the Audio & Video panel. Click the icon again to close
the preview.
To transmit your video during a session, in the Audio & Video panel, click Video. Click
Video again to stop transmitting your video.
To exit a collaborate session and close the window, on the File menu, click Exit, and
then in the Confirmation message box, click OK. Alternatively, use the close button on
the title bar of the window, and then in the Confirmation message box, click OK.

Use the whiteboard and the associated Tools palette
When you join a session, the page you view to the right of your Blackboard Collaborate window
is the whiteboard page. The whiteboard page is your Main Room and Public Page by default. If
you have active permissions, you can enter text, point to areas of interest, draw, and insert
screenshots on your whiteboard page to present information. You can use the options on the
Tools palette to present different types of information on your whiteboard page. The Tools
palette is available to the right of the Side Bar by default. Point your cursor to each option on the
tools palette to view the description for that option. To move or relocate the Tools palette, click
an area on the palette and drag it to the required location.
Let us now look at how you can use the options on the Tools palette:

1. To enter text on your whiteboard page, on the Tools palette, double-click the Text
icon, and then click an area on the whiteboard page. You will notice that a text box is
placed in that area of the page. In the text box, type your text. A content editor toolbar
appears below the Tools palette. You can format your text by using the options on this
toolbar. Click an area in the window to hide the content editor toolbar.
2. To create a text label on your whiteboard page, on the Tools palette, click the Text

icon, from the two options, select the Text label
option, and then click an area on
the whiteboard page where you want to insert the label. A text box is displayed in that
area. In the text box, type the content for your label.

3. To capture a screenshot of a document or an application window, minimize the
Blackboard Collaborate window, open the required document or application. Next,
maximize the Blackboard Collaborate window, and then in the Tools palette, click the

Screen shot
icon. You will notice that a rectangular selection area appears on your
document. Click and move the rectangular selection to position it on the required area of
your document or application window. Drag the corners of the rectangle to enlarge the
selection area, and then click OK.
4. To insert the screenshot, in the Blackboard Collaborate window, move your cursor to
the area on the whiteboard page where you want to place the screenshot, and then click
that area of the pages. Note that, after you click OK and capture the screenshot, the view
automatically toggles to display your Blackboard Collaborate window. You don’t need to
manually switch between your document view and the Blackboard Collaborate window
view.
5. To point to an area of interest on the whiteboard page, on the Tools palette, click the

Pointer
icon, from the list, select the required pointer, and then click the required
area on the whiteboard page. If you click a different area on the page, the pointer moves
to that area.
6. To underline or highlight a text on the whiteboard page, on the Tools palette, click the
Pencil
icon, select a width for the pencil stroke, and then on the whiteboard page,
click and draw under the required text.

7. To draw a shape outline such as rectangle, square, circle or ellipse, on the Tools palette,
click the Square
page.

icon, select a shape, and then drag your cursor on the whiteboard

8. To insert a clip art, on the Tools palette, click the Clip art
icon, and then from the
different categories available in the Clip Art dialog box, select a clip art and click the
area on the whiteboard page where you want to place the clip art. Click the close button
on the title bar to close the Clip Art dialog box.
9. To delete an object you added to the whiteboard page, on the Tools palette, click the

Select
icon. Next, on the whiteboard page, right-click the object you want to delete,
and then on the right-menu, click Delete Objects.
10. To delete all objects that you added to the whiteboard page, in the Blackboard
Collaborate window, on the Edit menu, click Select All. Next, right-click, and then on
the right menu, click Delete Objects.
Access a recorded collaborate session
The Collaborate tool in your LMS allows you to access and view recorded sessions. Your
instructors can use the recording feature in the tool to record live sessions and make them
available to you. The tool also includes features that enable your instructors to convert a
recorded session into multiple formats such as Audio, Video, and Blackboard Collaborate.
Accordingly, you can view the recorded sessions in a format that suits you.

Let us now look at how you can access and view recorded sessions:

1. To access a recorded session, on your subject’s navigation menu, click the link with the
word Collaborate in it, and then on the corresponding Collaborate page, click the link for
the recorded session. This displays a page with the recording title at the page header.
2. To view the recorded session in the video format, on the recording page, in the Video

column, click the Play
button for that recording.
3. To view the recorded session in the Blackboard Collaborate format, on the recording
page, in the Title column, click the recording title. Alternatively, in the Blackboard
Collaborate column, click the Collaborate

icon for that recording.

Internet Explorer users
4. In the notification bar at the bottom of your IE window, click Open.
5. In the Security Warning dialog box, under Do you want to run this application?, click
Run.
Firefox users
4. In the Opening play.collab dialog box, click OK.
5. In the Security Warning dialog box, under Do you want to run this application?, click
Run.

Chrome users
4. In the downloads bar at the bottom of your Chrome screen, click the play.collab file.
5. In the Security Warning dialog box, under Do you want to run this application?, click
Run.
View a recorded collaborate session
Let us look at how you can use the different options in the Blackboard Collaborate window
when viewing a recorded session:

1. To play or pause the recording, on the bar at the bottom of the Blackboard Collaborate

window, click the Play or Pause
button.
2. To manually adjust the volume for your headphones or speakers, in the Blackboard
Collaborate window, in the Audio & Video panel to the left, move the slider next to the
volume icon. To setup your headphones or speaker, please refer to the Set up your
Audio and Microphone section of this guide.
3. To stop or fast forward the recording, in the Blackboard Collaborate window, on the
menu bar, click Playback, on the drop-down menu, point to Player, and then on the
submenu, click Stop or Fast Forward.
4. To hide the Side Bar and expand the page view, on the menu bar, click View, and then on
the drop-down menu, click to unselect the Show Side Bar option.
5. To move within the recording, on the bar at the bottom of the window, drag the
indicator along the timeline of the recording.
6. To expand and view the session recording index, in the bottom-left corner of the
window, click Main Room. Alternatively, on the Playback menu, click Show Recording
Index.
7. To move to a specific topic or page in the recording, click and expand the session
recording index, and then in the index, click the title for the required page or topic.
8. To view a previous or the next page in the recording, on Playback menu, click Skip
Back or Skip to Next.
9. To print a page from the recorded session, on the menu bar, click File, on the drop-down
menu, point to Print, and then from the submenu, select Whiteboard. Next, in the
Select Pages dialog box, click to select if you want to print All Pages, Current Page, or
Selected Pages.
10. To print selected pages from the recorded session, in the Select Pages dialog box, click
the Selected Pages option, and then in the drop-down box, scroll down to the required
page and click the page. To select multiple pages, Windows users press Ctrl key, and
click the required pages where as mac users, press command key, and click the
required pages.
11. Next, in the Select Pages dialog box click OK. Now, in the Page Setup dialog box, select
the required page setup options, and then click OK.
12. To print the pages, in the Print dialog box, under Printer, in the Name list, select your
printer, in the Copies section, specify the number of copies, and then click OK.
13. To exit the recorded session, on the File menu, click Exit, and then in the Confirmation
message box, click OK. Alternatively, use the Close button of the window, and then in the
Confirmation message box, click OK.

